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1 Introduction
I was asked by the SA4 chair to quicky explain how SWG on Video and MBS is built-up. There is no magic around this, it is some hand-crafted work. However, he asked me to provide an overview as it may be useful for other SWGs, and who know if and when I will finally not be around anymore. And also, I am always open to learn and get ideas for improve and automize.
There is no proposal associated with this document.

2 Creating the Report

Here are the steps

1) Go to Google docs and create an empty doc https://docs.google.com/document/u/0/
2) Get the agenda provided by the chair

3) Copy the agenda rows as plain text

4) Apply Style “Title” for the first line
5) Apply Style “Heading 2” for all other lines

6) Copy into the ‘Opening of the session’ the information from a previous report, for example here and adjust gradually – no panic, things will come together. Could look like this.
Mr. Gilles Teniou (Tencent, Chairman of Video SWG) opens Video SWG on April 7, 2021 at 0830 CEST. 
E-mail discussion started already on Tue, 6 Apr 2021 10:08:49 +0000 
Schedule:
<to be added>
Mr. Thomas Stockhammer (Qualcomm) is assigned as scribe.
The minutes are shared online.
Attendees are listed here, please add attendance ‘Y’.
All e-mail discussions during the meeting can be tracked here: 
· https://list.etsi.org/scripts/wa.exe?A1=ind2104A&L=3GPP_TSG_SA_WG4_VIDEO
· https://list.etsi.org/scripts/wa.exe?A1=ind2104B&L=3GPP_TSG_SA_WG4_VIDEO
Final Timestamp for e-mail discussions considered in the report: Tue, 13 Apr 2021 13:02:34 +0000
The agenda and the registration of documents are agreed.
7) On Google docs, press ‘Share’, save the report according to the title, at ‘Get link’ press ‘Change to anyone with the link’ to Editor, copy the link, and add the link at the start of the report at the “The minutes are shared online.”
8) Copy into the AOB and close of session the information from a previous report, for example here and adjust gradually
9) Under every work item, copy the WID description

a. WID: SP_200399 New SID on 5G Glass-type AR/MR Devices
10) Look at the document allocation of the chair and just copy all of them related tables into clause 2 (Registration of documents)
11) Download the excel of the meeting documents

12) Sort the TDocs according to Agenda Sort Order

13) Hide Column E-J

14) Copy the all columns A-D, K to a temporary word doc

15) Select all -> Table properties, specify height of rows to unset

16) Remove all documents that are not assigned to the Video SWG

17) Select a nice table design

18) Copy the table to clause 10.2.
19) Select a different table design (no header, no banded rows, remove last column, Select Font Size 10, AutoFit) with a consistent color

20) Cut each row separately from the separate table to the appropriate agenda item one by one.

21) Add below each document the following (better use an existing report) and add the presenter and the document number
E-mail Discussion:
Presenter:  
Online Discussion:
Decision:
S4-210xxx is noted/revised/agreed( to S4-210yyy).
22) Add a new heading 2 at the end “Attendees”

23) Go To the meeting and download the attendee list as csv, for example here: https://portal.3gpp.org/#/55930-meetings. In the csv delete all columns except 

	TITLE
	Family Name
	Given Name
	Employer Organization
	Attended


24) Beautify the table an copy it to the google docs

25) In the google docs, create a bookmark (Insert -> Bookmark) at the start of this session and copy the link
26) Copy the link and add it to the opening clause section.

27) Go to: https://calendar.google.com/calendar/u/0/r/search?q=Video
28) Use some snapshot tool to add the agenda for the SWG to the opening session

You are done – this takes around 60-90 minutes. The starting point report looks something like this then: https://docs.google.com/document/d/1OtEHLrio-LP1ERHwrcTzuAQ1jZFS6HydDk1-4MCX9qE/edit?usp=sharing
3 During the Meeting

During the meeting, the document is filled by two means
1) Online sessions. For each document that is discussed the following is added

a. Presenter

b. Discussion is tracked

c. Decision is documented

d. Disposition of doc is done

e. If a doc is revised, the doc is added to the report using a row accordingly

2) E-mail discussions are added prior to each online session

a. For this, copy the latest information from the web

b. Format it (for details see clause 4)
c. Add it to the documents

d. Dispose documents that are not discussed in the meeting
4 Adding e-mail Agreements

For adding e-mail agreements to the report, the following process is applied
· Copy the Table from the 3GPP list to a word document, e.g. here, but make sure that you only take the new information. For this, keep the time stamp of the latest e-mail in the document in the opening session. https://list.etsi.org/scripts/wa.exe?A1=ind2104A&L=3GPP_TSG_SA_WG4_VIDEO
· An example table is provided in clause 7.
· The SortEmail() macro can be applied which first removes all “Re: “ and then sorts according to subject and date
· The beautify the table, also see clause 7. delete size column, delete header, format accordingly, remove spaces, and so on)
· The copy the relevant rows below the e-mail discussion on by one

· Update the time stamp with the latest information

This process should take around 15min and should be done before every SWG session at least for the relevant documents.

Intermediate versions of the report may be dumped. For this, go to File -> Downloads in google docs and download the docx version. The timestamp of the dump is added and an e-mail is sent to the list.

5 Wrap-up

After the meeting is completed, report is checked:

· All e-mail agreements are added

· All documents have a disposed status

· All documents that are presented to SA4 plenary are mentioned.

· Beautify everything.

· The final version of the report is then dumped. For this, go to File -> Downloads in google docs and download the docx version

· And finally all documents are linked. For this the macro HyperLinksToDoc() macro is executed in the dumped document.

These minutes are then sent to the SWG chair.
This process takes typically another 30 to 45min.
6 Useful Macros

Sub HyperLinksToDoc()
' Macro created September 9th 2008 by Arnaud Meylan '
    ''''' Selection mode ''''
    If (Selection.Words.Count > 1) Then
        ''store begin and end
        Dim beginPos, endPos
        Selection.Start = Selection.Start - 1
        beginPos = Selection.Start
        endPos = Selection.End
        'MsgBox "Begin end " & beginPos & " " & endPos
    
    ''''' Whole document mode ''''
    Else
        endPos = ActiveDocument.Range.End
        Selection.GoTo What:=wdGoToLine, Which:=wdGoToAblsolute, Count:=1
    End If
    
    Dim Message, Title, Default, thePath, theRegExp, prevTotal
    Title = "       Link-O-Matic for 3GPP! (step 1/2)       "    ' Set title.
    Default = "http://www.3gpp.org/ftp/tsg_sa/WG4_CODEC/TSGS4_88/Docs/"    ' Set default.
    thePath = InputBox("Enter path for the TDocs, including trailing '/', example 'http://www.3gpp.org/ftp/tsg_sa/WG4_CODEC/TSGS4_88/Docs/'", Title, Default)
    If (thePath = "") Then
    Exit Sub
    End If
      
    Title = "       Link-O-Matic for 3GPP! (step 2/2)       "    ' Set title.
    Default = "S4-16"    ' Set default.
    theRegExp = InputBox("Enter the first four characters of the TDocs to hyperlink, example 'S4-16'", Title, Default)
    If (theRegExp = "") Then
    Exit Sub
    End If
       
   
    With Selection.Find
  
        .Forward = True
        .Wrap = wdFindContinue
        .Format = False
        .MatchCase = False
        .MatchWholeWord = True
        .MatchByte = False
        .CorrectHangulEndings = False
        .MatchAllWordForms = False
        .MatchSoundsLike = False
        .MatchWildcards = True
        .MatchFuzzy = False
        
        
        Do While .Execute(FindText:=theRegExp & "[0-9]{4}") = True
            If Selection.Start > endPos Then
                'MsgBox ("Done, now at " & Selection.Start & ". Must end at " & endPos)
                Exit Do
            End If
            prevTotal = ActiveDocument.Range.End
                        
            ActiveDocument.Hyperlinks.Add Anchor:=Selection.Range, Address:= _
            thePath & Selection.Text & ".zip", TextToDisplay:=Selection.Text
            endPos = endPos + ActiveDocument.Range.End - prevTotal
            
         Loop
          
        End With
    
    'clear selection
    Selection.SetRange Selection.Start, Selection.Start
    
End Sub


Sub SortEmail()

'

' SortEmail Macro

'

'

    Selection.Find.ClearFormatting

    Selection.Find.Replacement.ClearFormatting

    With Selection.Find

        .Text = "Re: "

        .Replacement.Text = ""

        .Forward = True

        .Wrap = wdFindAsk

        .Format = False

        .MatchCase = False

        .MatchWholeWord = False

        .MatchWildcards = False

        .MatchSoundsLike = False

        .MatchAllWordForms = False

    End With

    Selection.Find.Execute Replace:=wdReplaceAll

    Selection.Sort ExcludeHeader:=True, FieldNumber:="Column 1", SortFieldType _

        :=wdSortFieldAlphanumeric, SortOrder:=wdSortOrderAscending, FieldNumber2 _

        :="Column 3", SortFieldType2:=wdSortFieldDate, SortOrder2:= _

        wdSortOrderAscending, FieldNumber3:="", SortFieldType3:= _

        wdSortFieldAlphanumeric, SortOrder3:=wdSortOrderAscending, Separator:= _

        wdSortSeparateByCommas, SortColumn:=False, CaseSensitive:=False, _

        LanguageID:=wdEnglishUS, SubFieldNumber:="Paragraphs", SubFieldNumber2:= _

        "Paragraphs", SubFieldNumber3:="Paragraphs"

End Sub
7 Example Table

This is the original table
	Subject
	From
	Date [image: image1.png]



	Size

	Re: [FS_5GVideo, 572, Block A, 7th Apr. 2200CEST] On Messaging and Social sharing source sequences
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 22:24:23 +0000
	635 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Champel MaryLuc
	Wed, 7 Apr 2021 22:22:15 +0000
	875 lines

	Re: [FS_5GVideo, 572, Block A, 7th Apr. 2200CEST] On Messaging and Social sharing source sequences
	Thomas Stockhammer
	Wed, 7 Apr 2021 21:27:17 +0000
	567 lines

	Re: [FS_5GVideo, 572, Block A, 7th Apr. 2200CEST] On Messaging and Social sharing source sequences
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 20:32:12 +0000
	444 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 20:14:34 +0000
	1095 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Ahmed Hamza
	Wed, 7 Apr 2021 20:08:04 +0000
	1026 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Sanchez de la Fuente, Yago
	Wed, 7 Apr 2021 19:21:20 +0000
	829 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Thomas Stockhammer
	Wed, 7 Apr 2021 18:57:47 +0000
	996 lines

	Re: [FS_5GVideo, 572, Block A, 7th Apr. 2200CEST] On Messaging and Social sharing source sequences
	Thomas Stockhammer
	Wed, 7 Apr 2021 18:34:18 +0000
	284 lines

	Re: [FS_5GVideo, 465, Block A, 7th Apr. 2200CEST] Screen Content Sequence
	Fabrice Plante
	Wed, 7 Apr 2021 10:56:00 -0700
	116 lines

	Re: [FS_5GVideo, 460, Block A, 7th Apr. 2200CEST] Verification
	Thomas Stockhammer
	Wed, 7 Apr 2021 17:31:29 +0000
	362 lines

	Re: [FS_5GVideo, 460, Block A, 7th Apr. 2200CEST] Verification
	Michel Kerdranvat
	Wed, 7 Apr 2021 16:51:08 +0000
	360 lines

	Re: [FS_5GVideo, 464, Block A, 7th Apr. 2200CEST] Updates on reference sequences
	Thomas Stockhammer
	Wed, 7 Apr 2021 16:32:30 +0000
	296 lines

	Re: [FS_5GVideo, 464, Block A, 7th Apr. 2200CEST] Updates on reference sequences
	Michel Kerdranvat
	Wed, 7 Apr 2021 16:25:42 +0000
	250 lines

	Re: [FS_5GSTAR, 447, Block A, 7th Apr. 1200CEST] 5G_EDGAR functionalities
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:53:21 +0000
	892 lines

	Re: [FS_5GVideo, 464, Block A, 7th Apr. 2200CEST] Updates on reference sequences
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:46:49 +0000
	184 lines

	[FS_5GVideo, 462, Block A, 7th Apr. 2200CEST] FullHD streaming sequences
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:41:45 +0000
	199 lines

	Re: [FS_5GVideo, 461, Block A, 7th Apr. 2200CEST] Status
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:35:53 +0000
	191 lines

	[FS_5GVideo, 460, Block A, 7th Apr. 2200CEST] Verification
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:29:48 +0000
	247 lines

	Re: [FS_5GSTAR, 513, Block A, 9th Apr. 0600CEST] Immersive downlink procedures for Edge-assisted STAR UEs
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:11:23 +0000
	274 lines

	Re: [FS_5GSTAR, 513, Block A, 9th Apr. 0600CEST] Immersive downlink procedures for Edge-assisted STAR UEs
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:11:12 +0000
	273 lines

	Re: [FS_5GSTAR, 447, Block A, 7th Apr. 1200CEST] 5G_EDGAR functionalities
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:11:02 +0000
	847 lines

	Re: [FS_5GSTAR, 446, Block A, 7th Apr. 1200CEST] Use case on AR gaming
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:55 +0000
	345 lines

	Re: [FS_5GSTAR, 510, Block A, 7th Apr. 1200CEST] Draft TR 26.998
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:47 +0000
	609 lines

	Re: [FS_5GSTAR, 427&436, Block A, 7th Apr. 1200CEST] ETSI ARF(Internet mail)
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:40 +0000
	385 lines

	Re: [FS_5GSTAR, 445, Block A, 9th Apr. 0600CEST] Proposed Architectures for AR Conversational Services
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:30 +0000
	324 lines

	Re: [FS_5GSTAR, 504, Block A, 9th Apr. 0600CEST] Updated Workplan
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:21 +0000
	734 lines

	Re: [FS_5GSTAR, 508, Block A, 9th Apr. 0600CEST] Content formats and codecs
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:13 +0000
	632 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:10:04 +0000
	894 lines

	Re: [FS_5GSTAR, 512, Block A, 9th Apr. 0600CEST] Immersive downlink procedures for EDGAR UEs
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:09:50 +0000
	604 lines

	[FS_5GSTAR, 505, Block A, 7th Apr. 1200CEST] Mapping to 5GS architecture
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:09:30 +0000
	198 lines

	[NEW WORK, 551, Block A, 9th Apr. 0600CEST] New Work Item description on 8K TV over 5G
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:08:32 +0000
	157 lines

	Re: [NEW WORK, 472, Block A, 7th Apr. 1200CEST] New Work Item description on 8K TV over 5G
	teniou(TeniouGilles)
	Wed, 7 Apr 2021 15:08:16 +0000
	335 lines

	Re: [FS_5GVideo, 567, Block A, 7th Apr. 2200CEST] Updates to 4KTV scenario
	Thomas Stockhammer
	Wed, 7 Apr 2021 14:38:50 +0000
	304 lines

	Re: [NEW WORK, 472, Block A, 7th Apr. 1200CEST] New Work Item description on 8K TV over 5G
	Thomas Stockhammer
	Wed, 7 Apr 2021 12:01:25 +0000
	292 lines

	Re: [FS_5GSTAR, 504, Block A, 7th Apr. 1200CEST] Updated Workplan
	Hakju Ryan Lee
	Wed, 7 Apr 2021 17:39:00 +0900
	729 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Liuyan (Scarlett)
	Wed, 7 Apr 2021 07:59:50 +0000
	409 lines

	Re: [FS_5GSTAR, 512, Block A, 7th Apr. 1200CEST] Immersive downlink procedures for EDGAR UEs
	Sanchez de la Fuente, Yago
	Wed, 7 Apr 2021 07:19:33 +0000
	498 lines

	Re: [NEW WORK, 472, Block A, 7th Apr. 1200CEST] New Work Item description on 8K TV over 5G
	Thomas Stockhammer
	Wed, 7 Apr 2021 06:35:57 +0000
	225 lines

	Re: [FS_5GSTAR, 512, Block A, 7th Apr. 1200CEST] Immersive downlink procedures for EDGAR UEs
	Sanchez de la Fuente, Yago
	Wed, 7 Apr 2021 06:26:47 +0000
	388 lines

	Re: [FS_5GSTAR, 513, Block A, 7th Apr. 1200CEST] Immersive downlink procedures for Edge-assisted STAR UEs
	Imed Bouazizi
	Wed, 7 Apr 2021 06:08:04 +0000
	219 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Liuyan (Scarlett)
	Wed, 7 Apr 2021 05:54:09 +0000
	1141 lines

	Re: [FS_5GSTAR, 508, Block A, 7th Apr. 1200CEST] Content formats and codecs
	Sungryeul Rhyu
	Wed, 7 Apr 2021 13:32:46 +0900
	602 lines

	Re: [FS_5GSTAR, 510, Block A, 7th Apr. 1200CEST] Draft TR 26.998
	Hakju Ryan Lee
	Wed, 7 Apr 2021 13:31:38 +0900
	582 lines

	Re: [FS_5GSTAR, 510, Block A, 7th Apr. 1200CEST] Draft TR 26.998
	Thomas Stockhammer
	Wed, 7 Apr 2021 04:25:11 +0000
	211 lines

	Re: [FS_5GSTAR, 447, Block A, 7th Apr. 1200CEST] 5G_EDGAR functionalities
	Hakju Ryan Lee
	Wed, 7 Apr 2021 13:14:40 +0900
	776 lines

	Re: [FS_5GSTAR, 427&436, Block A, 7th Apr. 1200CEST] ETSI ARF
	Thomas Stockhammer
	Wed, 7 Apr 2021 04:09:25 +0000
	350 lines

	Re: [FS_5GSTAR, 509, Block A, 7th Apr. 1200CEST] Architecture and media flow for interactive services
	Imed Bouazizi
	Wed, 7 Apr 2021 03:29:53 +0000
	212 lines

	Re: [FS_5GSTAR, 508, Block A, 7th Apr. 1200CEST] Content formats and codecs
	Imed Bouazizi
	Wed, 7 Apr 2021 03:20:30 +0000
	224 lines

	Re: [FS_5GSTAR, 512, Block A, 7th Apr. 1200CEST] Immersive downlink procedures for EDGAR UEs
	Imed Bouazizi
	Wed, 7 Apr 2021 03:03:50 +0000
	260 lines

	Re: [FS_5GSTAR, 446, Block A, 7th Apr. 1200CEST] Use case on AR gaming
	[log in to unmask]
	Wed, 7 Apr 2021 10:52:07 +0800
	906 lines

	Re: [FS_5GSTAR, 447, Block A, 7th Apr. 1200CEST] 5G_EDGAR functionalities
	[log in to unmask]
	Wed, 7 Apr 2021 10:51:29 +0800
	283 lines

	Re: [FS_5GSTAR, 509, Block A, 7th Apr. 1200CEST] Architecture and media flow for interactive services
	Hakju Ryan Lee
	Wed, 7 Apr 2021 10:55:52 +0900
	626 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Hyun-Koo Yang
	Wed, 7 Apr 2021 10:11:43 +0900
	819 lines

	Re: [FS_5GSTAR, 447, Block A, 7th Apr. 1200CEST] 5G_EDGAR functionalities
	Imed Bouazizi
	Wed, 7 Apr 2021 00:55:18 +0000
	209 lines

	Re: [FS_5GSTAR, 446, Block A, 7th Apr. 1200CEST] Use case on AR gaming
	Imed Bouazizi
	Wed, 7 Apr 2021 00:49:30 +0000
	213 lines

	Re: [FS_5GSTAR, 504, Block A, 7th Apr. 1200CEST] Updated Workplan
	Hakju Ryan Lee
	Wed, 7 Apr 2021 09:36:49 +0900
	618 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Imed Bouazizi
	Wed, 7 Apr 2021 00:17:28 +0000
	267 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Champel MaryLuc
	Tue, 6 Apr 2021 22:54:49 +0000
	740 lines

	Re: [FS_5GSTAR, 504, Block A, 7th Apr. 1200CEST] Updated Workplan
	Thomas Stockhammer
	Tue, 6 Apr 2021 20:24:33 +0000
	226 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Thomas Stockhammer
	Tue, 6 Apr 2021 20:11:37 +0000
	606 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Sanchez de la Fuente, Yago
	Tue, 6 Apr 2021 20:02:34 +0000
	404 lines

	Re: [FS_5GVideo, 463, Block A, 7th Apr. 2200CEST] Messaging and social sharing
	Fabrice Plante
	Tue, 6 Apr 2021 11:59:03 -0700
	239 lines

	Re: [FS_5GSTAR, 427&436, Block A, 7th Apr. 1200CEST] ETSI ARF
	Christine Perey
	Tue, 6 Apr 2021 20:19:13 +0200
	284 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Liuyan (Scarlett)
	Tue, 6 Apr 2021 16:26:09 +0000
	942 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Liuyan (Scarlett)
	Tue, 6 Apr 2021 16:14:51 +0000
	617 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Ali El Essaili
	Tue, 6 Apr 2021 15:43:01 +0000
	841 lines

	Re: VIDEO SWG SA4#113-e meeting - Start of Block A
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 15:30:43 +0000
	442 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Hakju Ryan Lee
	Wed, 7 Apr 2021 00:29:25 +0900
	823 lines

	Re: [FS_5GSTAR, 470, Block A, 7th Apr. 1200CEST] Device considerations
	Hakju Ryan Lee
	Tue, 6 Apr 2021 23:59:33 +0900
	527 lines

	Re: [FS_5GSTAR, 447, Block A, 7th Apr. 1200CEST] 5G_EDGAR functionalities
	Hakju Ryan Lee
	Tue, 6 Apr 2021 23:46:12 +0900
	555 lines

	Re: [FS_5GSTAR, 427&436, Block A, 7th Apr. 1200CEST] ETSI ARF
	Hakju Ryan Lee
	Tue, 6 Apr 2021 23:34:47 +0900
	547 lines

	[FS_5GVideo, 462, Block A, 7th Apr. 2200CEST] FullHD streaming sequences
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:31:43 +0000
	155 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Liuyan (Scarlett)
	Tue, 6 Apr 2021 14:29:37 +0000
	441 lines

	[FS_5GVideo, 459, Block A, 7th Apr. 2200CEST] Proposed Editor's updates to TR
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:31 +0000
	163 lines

	[FS_5GVideo, 458, Block A, 7th Apr. 2200CEST] Workplan update
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:25 +0000
	158 lines

	[FS_5GVideo, 460, Block A, 7th Apr. 2200CEST] Verification
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:17 +0000
	149 lines

	[FS_5GVideo, 461, Block A, 7th Apr. 2200CEST] Status
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:14 +0000
	149 lines

	[FS_5GVideo, 463, Block A, 7th Apr. 2200CEST] Messaging and social sharing
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:13 +0000
	150 lines

	[FS_5GVideo, 568, Block A, 7th Apr. 2200CEST] Sequences for social messaging scenario
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:11 +0000
	150 lines

	[FS_5GVideo, 572, Block A, 7th Apr. 2200CEST] On Messaging and Social sharing source sequences
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:10 +0000
	151 lines

	[FS_5GVideo, 567, Block A, 7th Apr. 2200CEST] Updates to 4KTV scenario
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:08 +0000
	150 lines

	[FS_5GVideo, 465, Block A, 7th Apr. 2200CEST] Screen Content Sequence
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:05 +0000
	150 lines

	[FS_5GVideo, 464, Block A, 7th Apr. 2200CEST] Updates on reference sequences
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 14:26:02 +0000
	149 lines

	Re: [FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	Thorsten Lohmar
	Tue, 6 Apr 2021 13:39:05 +0000
	219 lines

	Re: [FS_5GSTAR, 509, Block A, 7th Apr. 1200CEST] Architecture and media flow for interactive services
	Thorsten Lohmar
	Tue, 6 Apr 2021 13:33:43 +0000
	216 lines

	Clarifications on Tdoc email agreements and tomorrow's VIDEO SWG session
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 11:55:43 +0000
	92 lines

	[FS_5GSTAR, 445, Block A, 7th Apr. 1200CEST] Proposed Architectures for AR Conversational Services
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 10:52:56 +0000
	162 lines

	[NEW WORK, 472, Block A, 7th Apr. 1200CEST] New Work Item description on 8K TV over 5G
	teniou(TeniouGilles)
	Tue, 6 Apr 2021 10:50:04 +0000
	161 lines

	[FS_5GSTAR, 513, Block A, 7th Apr. 1200CEST] Immersive downlink procedures for Edge-assisted STAR UEs
	teniou(TeniouGilles)
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